
RealPlayer Help Contents
Click on the topic below that you wish to view.

A quick explanation of how to use this Help File for anyone 
unfamiliar with Windows Help. Click on the book to the left 
to jump to the information.

            Introduction to RealPlayer   - A good place to get started.

            What  ’  s New in G2?   - Check out the new features in this version of RealPlayer.

            Using RealPlayer   - How to use RealPlayer's many features.

            Setting Preferences   - How to configure RealPlayer to work in your environment.

     Troubleshooting   - Solutions to common problems.

 A note to users of the free version of RealPlayer.



What's the difference between Plus and Free?

This Help file is constructed so that both RealPlayer Plus and RealPlayer users can find what they need. There 
are, however, considerable differences between the Plus and free versions of the Player. Those differences are 
marked as shown below.

Marks abilities and 
enhancements that are available 
only to RealPlayer Plus users.

Often this icon will appear in the banner at the top of a topic, but will also see it in the the middle of a topic 
when RealPlayer Plus offers additional features (such as Save Current Place... ). 

Remember, you can always upgrade to RealPlayer Plus or even get a subscription that will guarantee you the 
next version of RealPlayer Plus down the road. We strive to keep improving RealPlayer and a subscription puts 
you at the front of the line for the latest and greatest Internet technology out there.



What's New in G2?

              

              

 



 Equalizer panel  

To open your Equalizer click  next to the position slider on the main RealPlayer Plus interface.

 Click to open the Equalizer. When the 
Equalizer is on, a green light will appear 
beneath the Equalizer button on your 
RealPlayer. If it is off, a red light will 
appear.

The Equalizer panel is your central control for customized audio quality. 

Turns your equalizer on and off. By 
engaging and disengaging the equalizer 
you can better adjust the sound quality by
listening to the difference between the 
two. By default, the equalizer is not on. 

Note: In some cases the equalizer will 
slow down your machine. Turning it off 
should return your computer to its normal 
speed.

The central sliders allow you to adjust 
specific frequency ranges (in this example
the 31 Hz range) to your own preferences 
as you would with a graphic equalizer.    

If you find you don't like your adjustments,
clicking Reset will bring all of the sliders 
back to the zero, the central mark on each
slider.

Settings:

"setting"

Save 
Settings As...

Delete

A drop down box with the name of the 
slider settings. RealPlayer comes with a 
number of precreated settings for your 
convenience which you can alter or add to
as you wish.

Opens a Save As... dialog to save the 
current settings with a name for later use.

Deletes setting currently displayed in the 
drop down area to the left of this button.



See Also:

Audio Analyzer 
Display Color Controls 
Sharing Presets 
Search 
AutoUpdate 
RealPlayer Interface



Frequency Handling
The Equalizer is divided into 10 specific ranges between 31Hz to 16kHz and can alter the frequency to plus or 
minus 18 decibels. These alterations are done on the fly and are reflected in the Audio Analyzer.

In the case of particularly poor quality sound, the upper sliders will be disabled.



Graphic Equalizer

What is it?

A graphic equalizer lets you tune more specifically your audio experience by dividing the sound input into 
smaller ranges of tones. Each range is then assigned to a slider on your Equalizer panel. This gives you control 
over each individual range rather than having to adjust all the high or low tones as typical treble and bass 
buttons do.

How do I use it?

Lower frequencies (bass) are the left half of the sliders, while higher frequencies (treble) are on the right. Going 
from left to right, each slider affects a slighter higher tone than the one before it.

You increase the volume of any given range by dragging a slider up and decrease it by dragging the slider down.
The center position effectively leaves the incoming frequency unchanged.



 Display Color Controls

 Clicking the Display Controls button on your RealPlayer Plus main interface will pop-up the Display Controls 
panel. Adjust the sliders on the various controls to change the look of the display. Clicking anywhere else or on the 
control again will close the slider. Your settings are retained until you change them. The Display Controls will not be 
available if the clip you are playing does not support the controls.

Display Controls allow you to 
adjust your RealVideo clips or
a clip's RealVideo 
components without having 
to change the look of your 
entire desktop.

Contrast Adjusts the contrast, altering the 
degree of difference between the 
light and dark shades in the clip.

Brightnes
s

Adjust the brightness, how light the 
picture appears overall.

Color 
Level

Adjusts the color saturation of the 
picture, how brilliant the colors are.

 Tint Adjusts the overall hue of the 
picture.

 Sharpnes
s

Adjusts the clarity of the edges in 
the picture.

See Also:

Audio Analyzer 
Equalizer panel 
Sharing Presets 
Search 
AutoUpdate
RealPlayer Interface 



Audio Analyzer
 
For those who have to know exactly what's coming into your system, RealPlayer has given you four configurable
tools to monitor sound frequencies. When selected, they appear below the image area of the Display Panel 
while you are playing a clip.

The Audio Analyzer has four modes:

Spectrum A very narrow band, bar-graph 
styled analyzer which you can 
configure to your liking. The 
Spectrum analyzer tracks in real 
time over 100 discreet 
frequencies.

Spectrogram An aggregate view of the sound 
in time-slices presented as a 
spectrum of color.

Waveform An oscilloscope styled analyzer 
that entertains your eyes but no 
less accurately measures the 
peaks and troughs of the 
frequencies.

Graph A 16-band bar-graph styled 
analyzer which you can configure
to your liking.

See Also:

Display Color Controls 
Equalizer panel 
Sharing Presets 
Search 
AutoUpdate
RealPlayer Interface 



Search
With so many clips out there to enjoy, how do you find what you want to listen to or what you want to watch?
The answer is Search. Search works just like any other search engine you may have used to find web pages.

1. Just type in words or phrases related to the subject you're interested in.
2. Click Search or press ENTER
3. Your web browser will open, if it isn't already, and will display a results page listing clips that meet your search request. Unlike

most search engines, results from your search will only include links that have streamed media associated with them. 

Note: You must be connected to the Internet for Search to function. If you are not connected to the Internet when you initiate the 
search, your computer will attempt to connect to the Internet at that time.

See Also:

Display Color Controls 
Equalizer panel 
Sharing Presets 
AutoUpdate
Audio Analyzer 
RealPlayer Interface



 Introduction to RealPlayer
Welcome to RealPlayer G2 by RealNetworks. RealPlayer gives you quality, "one-button" access to the news and 
entertainment that you want to experience.

Using RealPlayer, you can listen to and view thousands of hours of live and pre-recorded clips, including sporting
events, live radio stations, news, interviews, music, and lectures. RealPlayer allows you to save your favorite 
locations quickly and easily, scan for new stations, even to share presets with your friends.

Tell me more about how RealPlayer works

Visit the RealNetworks website for the latest information at http://www.real.com

See Also:

Using RealPlayer 
What's New in G2? 
RealPlayer Components 
PlusZone 
Troubleshooting 

How to use this Help File



 How does RealPlayer work?

RealPlayer retrieves audio, video, text, animation and other media to your desktop faster by using streaming 
technology.

Servers on the Internet store media files. You access them by clicking a link on a browser page, or by going to a 
page that has the clip automatically set to launch for you. The media files, or clips , you play are specially 
created so that they come to your desktop in much smaller pieces that are ready to be used. Because of this, 
you don't have to wait for a whole video file, for instance, to be downloaded before you get to begin to enjoy it. 
With RealPlayer, the video plays as your Player receives the information. 

 RealPlayer Plus owners can read much more about streaming media in the RealPlayer Plus G2 Manual 
(Chapter 6: What is Streaming Media and How Does it Work?) available in hardcopy or in HTML by choosing On-line
tutorials from your Help menu and then selecting On-line Manual from the menu that appears in your Player.
Media files can be compiled with different options. Those options are selected by the person providing the content 
you get from the Internet, not by RealPlayer. Because of this not all files will be recordable, for example. When an 
option is unavailable, the button or the menu option will not be accessible.

Different media files require different components, or plug-ins, to be played. RealNetworks is constantly adding 
new components to the Player. If you attempt to play a file that requires a new component, RealPlayer will 
inform you and offer to install the new component from our own servers if one is available.

See Also:

Using RealPlayer 



 RealPlayer Components
In addition to RealPlayer, several different special-purpose RealPlayer components are installed on your 
computer. These components work with different elements in    World Wide Web pages to deliver sound and 
video in a variety of ways. Among these are:

RealPlayer 
Netscape Plug-in 

The Plug-in provides access to RealMedia 
programming and extends the audio and 
video capabilities of your Netscape browser 
(Netscape Navigator 3.0 or later). 

RealPlayer 
Control for 
ActiveX

The RealPlayer Control for ActiveX provides 
access to RealMedia programming and 
extends the audio and video capabilities of 
your Internet Explorer browser (3.0 or later) 
and Visual Basic applications.

See Also:

AutoUpdate 

Don't forget the Readme file. For quick access go to your Windows Start menu, select Real and RealPlayer G2
Readme. The Readme file is stored in the directory where your RealPlayer is installed.



 AutoUpdate and Security

AutoUpdate notification alerts you to major new improvements of RealPlayer. It will not inform you 
of new components. If you attempt to play a clip that requires additional components, RealPlayer 
will offer to find and install the new component at that time.

RealNetworks authenticates every update to your Player with electronic certificates before any files 
are released onto your computer. In the event of unauthorized code, the files are deleted, before 
they are installed or run, and RealNetworks will be informed automatically so the code provider can 
be investigated.

This is NOT the same as virus protection. RealNetworks does check its own code on a frequent 
basis to protect both itself and you. However, virus protection is each user's individual 
responsibility. 

See Also:

Upgrade Preferences 



AutoUpdate and Security
AutoUpdate notification alerts you to major new improvements of RealPlayer. It will not inform you 
of new components. If you attempt to play a clip that requires additional components, RealPlayer 
will offer to find and install the new component at that time.

RealNetworks authenticates every update to your Player with electronic certificates before any files 
are released onto your computer. In the event of unauthorized code, the files are deleted, before 
they are installed or run, and RealNetworks will be informed automatically so the code provider can 
be investigated.

This is NOT the same as virus protection. RealNetworks does check its own code on a frequent 
basis to protect both itself and you. However, virus protection is each user's individual 
responsibility. 



 PlusZone
The PlusZone is the one-stop Web site for Plus customers only; part of our commitment to you for purchasing 
the RealPlayer Plus.

The PlusZone provides links to some of the previous week's most frequently played Real content and other links 
that are updated on a weekly, or even more frequent, basis. You'll also be able to find updated product 
information, online offers, and premium content as well as on-line manuals and tutorials. 

Come to the PlusZone. Learn    More about the RealPlayer Plus and find out about special offers for Plus owners 
only! 

http://pluszone.real.com/



 Using RealPlayer
RealPlayer begins playing clips almost instantly without excessive download delays. Just click a RealMedia link 
and seconds later you'll be enjoying your favorite music, sports, videos, or news programs. You can even pause, 
rewind, fast-forward, stop, start, and record at the click of a button.

RealPlayer Interface
Click here to access a picture 
explaining what all those buttons 
and things are on your RealPlayer.

RealPlayer Menus 

Working with sound and video clips 

Windows, Panels and Bars 

Presets and Channels 

Scanning for Content

Keyboard Shortcuts     



Working with sound and video clips
The following assumes that you already have a clip loaded.

Button Action Note

Play Plays a clip from the beginning or 
from where you paused it.

Pause Pauses playback of the clip. If you 
pause a clip for several minutes, 
you may be disconnected from the 
clip. If you resume playback there 
may be a delay while RealPlayer 
reconnects to the site.

Stop Stops and resets clip to the 
beginning.

Fast Forward The longer you hold down FF 
button, the further ahead in the clip
you will jump.

Rewind The longer you hold down REW 
button, the further back in the clip 
you will jump.

Mute Mutes sound of clip. Even though 
muted, a clip continues to play 
unless you stop or pause it.

See Also:

Loading a Clip     
File Menu     
Recording a Clip 
Playing Clips in PerfectPlay Mode
Keyboard Shortcuts 



Loading a Clip
Loading a clip means the Player knows the location of and is prepared to act on that clip. It does not mean that 
you are listening to the clip nor that you are currently connected to it. Loading a clip is like knowing where the 
store is, but you haven't left yet to go there, but as soon as you do leave, you know which streets to take to get 
there.

For example, When you click  the Player finds the will find the loaded clip and play it.

A clip remains active until you select a new clip. Just stopping a clip does not unload it. Stopping only resets the 
clip to play from the beginning. Just because a clip is loaded, however, does not mean you are necessarily 
connected to the Internet.

You can load a clip in several ways:

· Click a media link on an Internet page and your RealPlayer will launch automatically or the plug-in version 
(a video box or sound will begin as part of the page you are viewing) will load depending on how the page 
was created.

· Drag a file or link to your RealPlayer or RealPlayer icon on your Desktop. RealPlayer will launch and begin to
play the clip (If you release over the Presets tab, it will become a preset rather than launch).

· Select a Preset from the Presets Menu which will automatically access the media on the Web without 
opening your browser.

· Using File/Open from the drop down menus, choose a file from your local hard drive.

· Using File/Open location, enter a location (rtsp:// or pnm:// or http://) in the dialog box that appears. 

· Choose a recently opened clip at the bottom of the File Menu .

What if I disconnected from my ISP ?

If you are not connected and attempt to play a loaded clip, RealPlayer will try to establish a connection for you.

See Also:

Working with sound and video clips 

General Preferences 



Windows, Panels, Bars and Accessories
When launched, the RealPlayer has its own window on your desktop. Within the RealPlayer window there are 
several Panels and Bars (eg. the Status Bar).

Panels can be rearranged within the RealPlayer window. Position your mouse over the double bar on left portion 
of any Panel. When your cursor is a double arrow, click and drag the Panel to its new position and release.

Bars can also be rearranged within the RealPlayer window. Position your mouse over the double bar on left 
portion of any bar. When your cursor is a double arrow, click and drag the Panel to its new position and release.

Accessories (eg. the Equalizer panel) are panels that are part of RealPlayer but not attached to it. Accessories 
can be positioned anywhere on your desktop. 

Closing or minimizing RealPlayer will close or minimize all of the Accessories no matter their position on the 
desktop. 

See Also:

Changing the Size of the Image Area
Changing the Size of the RealPlayer Window
The RealPlayer Interface 



Presets and Channels
Presets are your quick access to content that you've found on the Internet. You collect, organize and use them 
from the Presets tab of the Content Panel.

Channels are links to content that you subscribe to through special links on the Channels page of RealNetworks 
or other pages on the Internet. Channels also update you with the latest top news and information from the 
content providers by using Headlines. Channels reside on the Channels tab of the Content Panel.

Visual Presets 

Selecting a Preset 

Creating a Preset 

Adding Presets 

Editing Presets 

Sharing Presets 

Organizing Presets 

Channels

Customizing your Channels 

Updating Headlines 

Customizing Your Daily Briefing 

See Also:

The RealPlayer Interface 



Adding Presets

Presets are your personal markers for media and programs that you want to get to quickly. You can add, delete 
and even organize your presets for easy use.

You can add Presets by:

· Choosing Add to Presets... from the Presets 
Menu while playing a clip.

· Accepting Presets sent to you by a friend or web 
page.

See Also:

Visual Presets
Selecting a Preset 
Sharing Presets 
Adding Presets 

Editing Presets 
Customizing Channels 

The RealPlayer Interface 

Save Current Place
Save Current Place is a quick way to bookmark not only a specific clip, but where you are in that clip. You can 
return to it at a later time and pick up right where you left off.

To save your current position in a clip:

Select the File menu

Click Save Current Place...

The placeholder that is created will be dropped into the Placeholders folder of your Presets with a Start Clip 
at... setting based on where you were in the clip when you asked it to Save Current Place.

Note: Save Current Place... will not be available if the stream is not capable of being searched (e.g. a live 
stream or a wave [.wav] file).

See Also:

Selecting a Preset 
Sharing Presets 
Adding    Presets 

Editing Presets 
Customizing Channels 

The RealPlayer Interface 

Visual Presets
Visual Presets are a quick and easy way to access often used content. Rather than using your Presets Menu to 
see a list of your media bookmarks, Plus customers get a visual representation on their Content Panel. 

Presets share the Content Panel with Channels.



 Click to open Visual Presets in the Content Panel .

To play an existing 
Preset:

To change Presets 
folders:

Click the name of the 
Preset.

Click the down arrow and 
select a new folder of 
Presets.

 The Edit menu on Visual Presets gives you quick access to other features:
Add to 
Presets...

Opens the Add to Presets... Presets 
dialog.

Organize
Presets...

Opens the Organize Presets dialog.

Scan 
'folder'

Opens the Scan Presets dialog and 
preselects the currently open folder.

Export
'folder'

Exports the open folder so you can mail 
them to friends..

Hint: Plus customers also have access to right-click options on their Visual Presets. Position your mouse over a 
Presets and click your secondary mouse button (the button you don't use as often) to get a list of additional 
actions.

See Also:

Customizing Channels 
Customizing Your Daily 
Briefing 
Adding Presets 
Organizing Presets 
Editing Presets 

Sharing Presets 
Selecting a Preset 
Creating a Preset 
The RealPlayer Interface 

Editing Presets
Using the Organize Presets dialog, you can modify the label of a Preset and the URL corresponding to that 
Preset.

To edit or delete a Preset:

· Select Oraganize Presets from your Presets Menu

· Select a specific Preset or Folder.

· Choose Delete or Edit

Edit will open the Edit Preset dialog:

Field Description
Title Enter the title you want for 

this Preset. 

URL Enter the URL (Internet 
address) you want to play 
when this Preset button is 
clicked. You must enter the 
full URL. For example: 
rtsp://presets.realaudio.co



m/plus/pop1.ram

Folder Enter or select the folder you 
would like the Preset to be a 
part of.

Play Preset from... This setting will start the clip 
playing from the specified 
time. The default setting is 
always the beginning of the 
clip (unless you used Save 
Current Place... to create the 
Preset.

See Also:

Adding Presets 
Selecting a Preset 
Organizing Presets 
Creating Presets 

Customizing Channels 
Updating Headlines 
Customizing Your Daily 
Briefing 
The RealPlayer Interface 

Sharing Presets

RealPlayer gives you the ability to trade Presets with your friends.

          To share a Preset or Folder:

                                           

1. Open the folder you wish 
to Export by selecting it on
your Visual Presets tab.

2. From the Edit menu on the
Visual Presets tab, select 
Export.

3. A Save As...  style dialog 
will open.

4. Name the export file and 
select a place for it to be 
saved as you would any 
word processor document 
but leave the .RNX 
extension so RealPlayer 
will recognize the file.

5. Select Save. A text file will
be created in your 
RealPlayer directory that 
can be sent via your e-mail
program.

If you wish to send a single 
Preset use the Organize 
Presets option listed to the 
right.

    If you don't own RealPlayer Plus:

1. From your Presets menu, 
select Organize Presets.

2. The Organize Presets dialog 
will open.

3. Choose the Preset or Folder 
you want to send

4. Select Export Preset (or 
Folder)

5. A Save As...  style dialog will 
open.

6. Name the export file and 
select a place for it to be 
saved as you would any word 
processor document but leave
the .RNX extension so 
RealPlayer will recognize the 
file.

7. Select Save. A text file will be
created in your RealPlayer 
directory that can be sent via 
your e-mail program.

To use Presets that you have received:



1. From your Presets menu, select Import.

2. An Open File... style dialog will open.

3. Select the file that you wish to Import by navigating to the proper folder.

4. Click Open. 

5. The Presets will Import into your RealPlayer.

Or simply double-click the file that you received in your Windows Explorer. RealPlayer will add it to your Presets 
automatically. 

See Also:

Visual Presets
Adding Presets 
Selecting Presets 
Organizing Presets 
Creating Presets 

Customizing Channels 
Updating Headlines 
Customizing Your Daily 
Briefing 

The RealPlayer Interface 

What's new in G2? 

 Creating a Preset
Presets allow you to jump quickly to content on the Internet, much like the buttons on a radio jump to your 
favorite stations.

Creating a new Preset:

To create a Preset 
(from the currently 
loaded clip)

From the Presets menu, 
select Add to Presets... 
the Add a Preset dialog will
open. If the title and folder
are what you would like, 
just click OK. Otherwise 
edit the title or folder.

To create a Preset 
(without a clip loaded)

In your Organize Presets 
dialog, choose New and 
enter the URL and other 
information.

See Also:

Visual Presets
Adding Presets 
Organizing Presets 
Editing Presets 
Selecting a Preset 

Customizing Channels 
Updating Headlines 
Customizing Your Daily Briefing

The RealPlayer Interface

Organizing Presets

Presets are grouped by folders. There is no practical limit to the number of folders you can create. 



To Organize your Presets:

· Select the Presets menu, then Organize Presets.

Select a specific Preset or Folder:
Click Edit to change a specific Preset's content, title, 
the folder it's associated with or to change a specific 
Folder title.
Click New Folder to create a new Presets folder.
Click Delete Folder or Delete Preset to permanently 
remove a specific Preset or a specific Folder from 
RealPlayer. Removing a folder removes all the Presets 
within that folder if you haven't moved them elsewhere
first. You cannot undelete a folder, so be careful

See Also:

Visual Presets
Adding Presets 
Selecting a Preset 
Sharing Presets 
 

Customizing Channels 
Updating Headlines 
Customizing Your Daily 
Briefing 

The RealPlayer Interface 

 Selecting a Preset

Presets are one-click access to your favorite media. Each preset has a    title, that you can change, associated 
with it. Clicking on the title will launch the clip or live connection associated with that Preset.

To select a Preset:
· Click the Preset you want to play.
· RealPlayer Plus will connect to the site and begin playing the clip.

To view other folders of Presets:
· Choose the folder from the drop down list on the Presets tab.
· Any clips in that folder will then be available.

 Both non-Plus and Plus users can select Presets from the Presets menu.
See Also:

Adding Presets 
Organizing Presets 
Sharing Presets 
Creating a Preset 

Customizing Channels 
Updating Headlines 
Customizing Your Daily Briefing

The RealPlayer Interface 



Channels

Channels are more than links to your favorite premium content. RealPlayer retrieves headlines on a regular 
basis from providers while you're connected to the web. Holding your mouse over a Channel will display the 
current Headline. You can even set the Headlines to scroll automatically.

If you're following a particular story or event, you can force an update of the headlines by choosing Update 
rather than waiting for the update to occur on its own.

RealPlayer comes with a number of Channels already loaded. Click on any Channel to connect to the service 
with which it's associated.

Channels share the Content Panel with Presets

Click to make Channels available on 
the Content Panel.

Allows you to add and delete 
Channels or even change the order in 
which Channels are displayed. 

Connecting to New Channels will 
stream information about New 
Channels that are available and other 
information. It will also activate your 
web browser to take you to a special 
web page. Follow the posted 
instructions there to change or 
reorder your Channels.

Forces an update of the Headlines 
associated with each Channel. If you 
are not currently connected to the 
Internet, RealPlayer will attempt to 
make a connection.

See also:

Customizing Channels 
Customizing Your Daily 
Briefing 
Adding Presets 
Organizing Presets 

Sharing Presets 
Selecting a Preset 
Creating a Preset 
The RealPlayer Interface 

Customizing Your Channels
There is no limit to the number of Channels you can add to your list. To view your Channels use the up and down
arrows to scroll them in a loop - when you reach the end it will go back to the beginning of the list and continue 
forward again.

To add or rearrange or delete your Channels:

· Click New Channels from your Channels list.

· A presentation will begin to show you new Channels that are available and other information.

· Your web browser will launch if it isn't already running and you will come to the Channels page.

· Follow directions on the page to add or rearrange Channels or to delete them from your line-up.



See Also:

Updating Headlines 
Customizing Your Daily 
Briefing 
Adding Presets 
Organizing Presets 

Sharing Presets 
Selecting Presets 
Creating Presets 

The RealPlayer Interface 

Updating Headlines
Headlines are provided by your Channel providers. 

RealPlayer updates your headlines on a regular basis when you are connected to the Internet. 

You can force an update of the Headlines anytime you are connected by clicking Update on the Channels tab of
the Content Panel to make sure you have the most current information available.

If you are not connected to the Internet when you request an update, RealPlayer will initiate a connection either 
by dialing your Internet provider or by establishing a connection over your network.

See Also: 

Adding Presets 
Organizing Presets 
Sharing Presets 
Selecting Presets 

Creating Presets 
Customizing Your Daily 
Briefing 
Customizing Channels 

The RealPlayer Interface 

Customizing Your Daily Briefing

The Daily Briefing Channel is a customizable news service. To personalize a multi-clip of various news services 
quickly, right-click the Daily Briefing icon on your Channels tab and select Customize Daily Briefing...; follow 
the instructions on the Daily Briefing web page to create your own special cup of news.

After you customize your service, selecting Daily Briefing on your Channels tab will connect you to the current 
news without having to find the links yourself.

See Also:

Customizing Channels 

Updating Headlines 

Adding Presets 

Organizing Presets 

Sharing Presets 

Selecting Presets 

Creating Presets 

The RealPlayer Interface 



 Recording a Clip

You can record your favorite clips for later playback from your computer (see note below). 

To start recording a clip prior to, or during, playback:

1. Click . 

2. A Save As... dialog box will appear after the clip has finished buffering.

3. Enter the filename and select the location on your computer where you want to save the file. 

4. Click OK when you have finished entering the information. 

5. RealPlayer Plus will begin recording. 

6. While RealPlayer Plus is recording, the record button will appear depressed    .

Some clips are really multi-clips, several files played one after another. If you choose to record a multi-clip (a 
clip that is really several clips in sequence), a new Save As... dialog box will appear at the beginning of each 
new clip in the sequence.

For best recording quality, select PerfectPlay Mode before you begin to record the clip and do not pause the clip 
while recording.

To stop recording:

    Stops RealPlayer Plus recording and resets the clip or simply click    

 again.

Note: Not all content can be recorded. Content 
providers control whether or not you may record a 
clip. If a clip is unavailable for recording, the 
record button will be disabled and will appear grey.

See Also:

Working with Sound and Video Clips 
Changing the Size of the RealPlayer Window 
Changing the Size of the Image Area 
Playing Clips in PerfectPlay Mode 
Selecting a Preset 
Creating a Preset 
Setting Up Your Channels 
Scanning Clips 



Changing the Size of the RealPlayer Window
RealPlayer can be adjusted to cover more or less of your desktop by accessing the View Menu .

· Normal displays all the controls and buttons and any panels and floating panes you've selected.
· Compact displays only a select group of buttons.

 Switches RealPlayer into Compact view. This view displays a subset of buttons, a smaller status bar and the 
image window (if playing a non audio-only clip).

See Also:

Changing the Size of the Image Area 
Working with sound and video clips 
Windows, Panels and Bars 



Changing the Size of the Image Area
You can enlarge the size of a video or RealFlash clip to Double Size or even to Full Screen. However, this 
increases the processing time required for playback. If your playback quality decreases or if your machine 
seems overloaded, you should return to Original Size.

To increase the image area size:

1. Click .
2. Select: Double Size or

Full Screen

To return to original size from double size:

1. Click .

2. Select the Original Size option.

To return to original size from full screen:

1. Click anywhere on the screen to return to original size.

When you choose the Full Screen option, sometimes the image is surrounded by a black border. This is normal 
for clips that have odd height-to-width ratios.

Note: In order to use the Full Screen feature, you must have Microsoft DirectX Tools with DirectDraw, and recent
video drivers, installed on your machine.

The first time you try to run a clip in Full Screen mode, the Player will need to run a short test to see if your 
DirectX and video drivers are functioning properly:

· RealPlayer will switch into Full Screen mode for 5 seconds. 
· You will have to confirm whether you saw the RealPlayer logo in Full Screen mode.

1. If yes, then the Player resumes the clip, switches to Full Screen mode, and you will not be asked to run 
the test in the future. 

2. If no, then you will be asked if you would like to refer to RealNetworks' Full Screen and DirectDraw 
information page.

See Also:

Working with Sound and Video Clips 
Changing the Size of the RealPlayer Window 



 Playing Clips in PerfectPlay Mode

PerfectPlay mode improves sound quality by increasing the amount of information that is buffered by RealPlayer
Plus before it begins to play a clip and by using a more refined playback mechanism. 

Playback quality, especially with 28.8 Kbps modems, should be enhanced with PerfectPlay, though the time 
before a clip begins to play will be slightly longer. You can adjust how much PerfectPlay buffers in your 
Preferences.

To enable PerfectPlay mode:
· Select PerfectPlay Mode from the Options menu.
· Connect to a new clip or play a loaded clip.

You must enable PerfectPlay before you begin to play a clip.

To return to Regular mode, select this option again. 

Note: You cannot use PerfectPlay mode with a live stream.

See Also:

Free Player's Buffered Play 
Working with Sound and Video Clips 
Recording a Clip 
Scanning for Clips 



RealPlayer - Buffered Play
Unlike PerfectPlay mode (a RealPlayer Plus only feature), Buffered Play in the free version of the Player improves
sound quality solely by increasing the amount of information that is buffered by RealPlayer Plus before it begins 
to play a clip.

Playback quality, especially with 28.8 Kbps modems, should be still be enhanced with Buffered Play, though the 
time before a clip begins to play will be slightly longer. You can adjust how much Buffered Play buffers in your 
Preferences.

To enable Buffered Play mode:
· Select Buffered Play from the Options menu.
· Connect to a new clip or play a loaded clip.

You must enable Buffered Play before you begin to play a clip.

To return to Regular mode, select this option again. 

Note: You cannot use Buffered Play mode with a live stream.

See Also:

PerfectPlay 
Working with Sound and Video Clips 
Recording a Clip 
Scanning for Clips 



 Scanning Stations
Scan Stations allows you to sample clips, similar to scanning stations on a radio, so you can find what you're 
in the mood to hear. RealPlayer plays each clip for the amount of time you specify on the Scan dialog and then 
continues on to the next clip in the list. When you Scan Stations you are contacting RealNetworks' servers 
which keep a list of live radio available for streaming.

Choose Scan Stations from the Options Menu. The Scan Stations dialog will open.

Start Scan Begins scanning through the 
selected category of stations. 
It will use the previously 
selected category if you have 
scanned before or All 
Categories if you selected 
nothing specific.

Stop Scan Stops the scan. Continues to 
play the clip you were 
listening to when you stopped
scanning.

More >> Expands the dialog to allow 
you to specify a category and 
Scan Time.

Less << Shrinks the dialog to hide the 
additional options.

Categories The categories of stations. By 
default. All Categories is 
selected if you do not choose 
a category specifically.

Scan Time The number of seconds 
RealPlayer will play of a clip 
before moving on to the next 
clip in the list.

Closing the Scan dialog by using  will have the same effect as clicking Stop Scan. 
While listening to any clip during the Scan you can save it, skip it or stop it as you would any other clip you might 
play.
See Also:

Working with Sound and Video Clips 
Scanning Presets
Keyboard Shortcuts



Scanning Presets
Similar to Scan Stations, Scan Presets will play portions from each Preset in a given folder, or work its way 
through all folders, for the amount of time you specify on the Scan dialog. 

Choose Scan Presets from the Presets Menu.

Start Scan Begins scanning through the 
selected Presets category. It 
will use the previously 
selected category if you have 
scanned before or All 
Categories if you select 
nothing specific.

Stop Scan Stops the scan and continues 
to play the currently running 
Preset.

More >> Expands the dialog to allow 
you to specify a category and 
Scan Time.

Less << Shrinks the dialog to hide the 
additional options.

Categories Your Presets folders. By 
default, All Categories is 
selected if you do not specify 
one.

Scan Time The number of seconds 
RealPlayer will play of a clip 
before moving on to the next 
clip in the list.

Closing the Scan dialog by using  will have the same effect as clicking Stop Scan.
While listening to any clip during the Scan you can skip it or stop it as you would any other clip you might play.

See Also:
Visual Presets
Working with Sound and Video Clips 
Scanning Stations 
Keyboard Shortcuts



How to use this Help File

Underlined text will bring you to a related topic or pop-up information related to the word or phrase that is 
underlined.

Occasionally you will see pictures or icons on the help page. If your cursor changes to  when you pass your 
mouse over the picture icon, clicking the icon will bring you someplace new or provide you with more 
information:

Points out a feature that is in RealPlayer 
Plus only.
The inner workings icon provides additional 
information    that some of us just can’t live 
without, but that no one really needs to know.

Sometimes you will see a picture of a 
dialog box or what your screen will look 
like when you are running RealPlayer. 
Clicking on various areas of these 
pictures will give you helpful 
information.

Click on the picture to the right to try 
this out.

See Also:

Windows Help



Inner workings example
If there were more to learn about a subject it would be explained here. 

For instance you might learn more about ActiveX which is the new name for OLE (Object Linking and 
Embedding) and is the current Microsoft standard utilizing Visual Basic 5 for web applets.



Pop-up example

Pop-ups give you small pieces of information without taking you somewhere new. The next time you click 
anywhere this pop-up will close.



Picture Example
Clicking on different areas will give you information about the specific areas your cursor was over when you 
clicked.



Jump-to Topic 
Sometimes a new window will open as this window did. Sometimes you will remain in the same window but a 
new information will appear.

When you close this window by clicking on the  in the upper right-hand corner of the menu-bar, you will 
return to the main RealPlayer Help.

See Also:
Windows Help



pop-up box
This box will disappear the next time you click your mouse.



Keyboard Shortcuts

Using the keyboard combination in the Hotkey column will initiate the response in the Action column. 

HotKey Action HotKey Action
CTRL+Left Arrow Rewind CTRL+L Open Location
CTRL+SHIFT+
Left Arrow

Super Rewind CTRL+O Open Local File 

CTRL+Right Arrow Fast Forward

CTRL+N Normal View

CTRL+SHIFT+
Right Arrow

Super Fast Forward CTRL+M Compact View

CTRL+A Add to Presets...
CTRL+Up Arrow Volume up CTRL+H Search 
CTRL+Down Arrow Volume down
CTRL+P Play/Pause CTRL + SHIFT+ A Save Current 

Place... 
CTRL+S Stop
CTRL+R Record F1 Help Contents
PgUp Previous Clip
PgDown Next Clip ALT+F4 Exit Program

CTRL= Control key
ALT = Alt Key
SHIFT = Left or Right Shift Key
'+' = use the listed keys in combination at the same time. For instance 'CTRL + A' directs you to hold down the Control key and 
press the letter 'A' on your keyboard at the same time.



 RealPlayer Menus
RealPlayer has six menus: File, View, Options, Presets, Sites, and Help. These menus allow you to take full 
advantage of RealPlayer features. 

File Menu
View Menu 
Options    Menu 
Presets Menu 
Sites Menu 
Help Menu 

For your convenience, we have also included a number of Keyboard Shortcuts for those who prefer the 'hot-key' 
approach. Shortcuts are shown to the right of menu items that have accelerators associated with them.



 File Menu
Commands from the File menu allow you to open and control the playback of clips without having to use your 
web browser, as well as to exit RealPlayer. 

Menu Option Description
Open Location... Allows you to play RealMedia files

on the Internet without using 
your web browser. In the Open 
Location dialog, enter the URL 
(Internet address) of any 
streamed content (eg., .rm, .ra, 
or .ram) file.

Open File... Opens and plays a file located on 
your hard drive. When the Open 
File dialog appears, select a 
media file (eg., .rm, .ra,  
or .ram) stored on your 
computer.

Save Current Place... A quick way to save the location 
of the clip you are currently 
playing as well as placing a 
bookmark where you were in the 
clip.

Playlist Offers menu access to the 
current Playlist rather than 
having to use the Playlist bar 

Next Clip Jumps to the next clip in a multi-
clip file or the next location when 
scanning.

Previous Clip Jumps to the previous clip in a 
multi-clip file or the next location 
when scanning.

Play/Pause Plays or Pauses the currently 
loaded clip.

Stop Stops the currently loaded clip 
and resets it back to the 
beginning.

Record Starts the Record process.

Most Recently Used 
list

Lists your most recently played 
clips. You can select a clip from 
this list to hear or view the clip 
again. The length of the list 
depends on your preference 
setting. .

Exit/Quit Exits RealPlayer.

See Also:

Keyboard Shortcuts



View Menu
Commands from the View menu allow you to control the appearance and view the performance of RealPlayer. 
Not all options are available at all times. Options are only available if they can affect the currently loaded clip. 

For example, if you are not playing a multi-clip, the Playlist Bar will not be available.

When Views are activated, a check mark appears next to the option. To de-activate an option, select it again 
and the check mark will disappear.

Menu Option Description
Normal Displays all RealPlayer buttons 

and controls.

Compact Displays only the image area, a 
subset of the buttons, and a 
reduced Status bar and menu 
selection.

Auto-Size Enable or disable Auto-hide 
when RealPlayer is in Compact 
mode. Auto-hide hides all 
controls unless your mouse is 
over the Player.

Audio Analyzer Displays/Hides the frequency 
analyzer. This has four modes: 
Wave, Spectrum or 
Spectrogram.    By selecting 
None you can turn off and hide 
the Audio Analyzer. Each mode 
displays realtime analysis of 
your audio feed.

Clip Info Shows/hides the Clip Info bar 
offering Title, Author, and 
Copyright about the currently 
playing clip or portion of a multi-
clip.

Playlist Shows/hides the Playlist bar. 
This item is not available if the 
current clip is not a multi-clip.

Content Panel Choose between displaying 
Presets [Plus only] and 
Channels.

Status Displays/Hides the Status Bar.

Channels

Customize 
Channels...

Update Headlines

Customize Channels... allows 
you to Add and Delete Channels 
to your line-up (the same as the 
Add button at the top of the 
Channels Tab). 

Forces an update of the 
Headlines displayed in the 
Channels Tab. These will update 
automatically at regular 
intervals when connected to the
Internet. This choice overrides 
the wait period and accesses 



Channel List

the information immediately-if 
you are not currently connected 
to the Internet, RealPlayer will 
attempt to dial-up or initiate a 
connection to do so.

Access any of your individual 
Channles by selecting it from 
your menu list. Headlines for 
each Channel will appear next 
to that Channel's listing.

Equalizer Opens the Equalizer panel.

RealPlayer add-ins Any third-party add-ins that you 
install will appear here on your 
menus (e.g., IQFXâ)

Statistics Opens the Statistics panel. The 
Statistics window reports the 
performance of the Internet 
connection between the Server 
and RealPlayer.

On Top While Playing Allows RealPlayer remain on top 
of all other windows, even when
another window is active.

Always on Top is convenient for 
keeping RealPlayer visible while 
you interact with your World 
Wide Web browser. 

See Also:

Keyboard Shortcuts



 Options Menu
The Options Menu lets you create your own media experience by allowing you to organize playback, Scan for 
new locations and modify your Channels. It also gives you access to the RealPlayer program preferences.

Menu 
Option

Description

Continuous 
Play

Loops your current clip(s). When 
RealPlayer reaches the end it will 
return to the beginning and play 
it through again... and again... 
When active, a checkmark will 
appear next to this selection. To 
turn it off, select the item again. 
You can combine this option with 
Shuffle Play.

Shuffle Play Randomizes the order of clips in 
a loaded multi-clip for playing. 
When active, a checkmark will 
appear next to this selection. To 
turn it off, select the item again. 
You can combine this option with 
Continuous Play.

Scan Stations Opens the Scan Stations dialog to
allow you to search for content 
on the Internet.

Perfect Play Turns on and off PerfectPlay 
Mode. You must turn on 
PerfetPlay before you begin to 
play a clip. PerfectPlay does not 
work on live streams. When 
active, a checkmark will appear 
next to this selection. To turn it 
off, select the item again.

Preferences... Opens your Preferences tab box.

See Also:

Keyboard Shortcuts 



Presets Menu
Presets are bookmarks for media whether out on the web or local to your computer. They are a 'friendlier' way 
to quickly get to the clips you want to play than typing in long and complex URLs. 

Menu Option Description
Add to Presets... Opens the Save As Preset dialog 

box and adds the current clip to the 
Folder you specify.

Open Visual Presets Opens Visual Presets tab on the 
Display Panel.

Organize... Opens the Organize Presets... 
dialog.

Scan Presets Scans through your Presets by folder 
or through all category folders.

Import... Opens Import Presets dialog.

Classical  
News  
Sports 

etc.

Display of your existing Presets by 
Folder.

See Also:

Editing Presets 
Customizing Channels 
Customizing Daily Briefings 
Updating Headlines 
Keyboard Shortcuts



 Sites Menu
Commands from the Sites menu give you quick access various Internet sites. This feature works with all popular 
web browsers. If you are connected to the Internet and your web browser is not open, RealPlayer opens it for 
you.

Menu Option Description
RealNetworks Home Page Find out more about the 

company that's brought you 
the RealPlayer.

RealPlayer Home Page Up to the minute RealPlayer 
information, links to sites, 
offers, updates and more.

RealPlayer Plus Home Page Links to the PlusZone(tm), a 
web site with exclusive offers
and support for RealPlayer 
Plus owners.

RealGuide :

An up to-the-minute 
resource for content on the 
web.

On Air
Live
News
Entertainment
Sports
Music
Business
Technology

MusicNet MusicNet Home Page

LiveConcerts.com LiveConcerts Home Page

Film.com    Film.com Home Page 
Screening Room 

Broadcast.com    Broadcast.com Home Page
Audio Books
CD Jukebox
Business Events
Sports
Live Radio

Web Active A RealNetworks project to 
offer progressive activists an 
up-to-date resource on the 
Web.

See Also:

Working with sound and video clips 
Customizing Channels 
Updating Headlines 
Keyboard Shortcuts



 Help Menu
Commands from the Help menu provide online help and information about RealPlayer.

The latest support and technical information is available at: 

http://service.real.com

Menu Option Description
Contents Opens this online help file.

Online Tutorial Starts the RealPlayer Plus online 
tutorials which describes several of
the major features of the Player. 
Also offers you a link to the on-line 
Manual which was designed to 
complement this Help file.

Common Questions Takes you to the RealNetworks 
Frequently Asked Questions (FAQ) 
web page. 

Search Knowledge Base Accesses the RealNetworks 
knowledge base on the web so you
can search for the answer to a 
question. 

Service & Support Takes you to the main 
RealNetworks Technical Support 
and Service Page. 

Submit Feedback... Connects to a web page that gives 
you the chance to let us know what
you think of your RealPlayer G2 or 
RealPlayer Plus G2.

Check for Upgrade... Queries the RealNetworks servers 
for upgrade information using 
AutoUpdate. A dialog box will 
appear to tell you if an update is 
available.

About this Presentation Displays copyright and other 
information about the currently 
loaded clip.

About RealPlayer
About RealPlayer Plus

Displays your RealPlayer or 
RealPlayer Plus version and 
copyright information.

See Also:

Troubleshooting 
Keyboard Shortcuts



The RealPlayer Plus Interface
RealPlayer Plus gives you the ability to experience media files over the Internet or over a local area network in 
real time, without having downloading the entire clip to your hard drive. When you click on a RealMedia link 
from a web page, RealPlayer automatically opens and plays the file you have selected.

Click on the buttons and areas of the RealPlayer Plus picture below to get information about their functions.

Click to find out more about:
{button Playing Clips,JI(`',`Working_with_sound_and_video_clips')}{button 
Presets/Channels,JI(`realplay.HLP',`Presets_and_channels')}{button 
Equalizer,JI(`realplay.HLP',`equalizer_panel')}{button Audio Analyzer,JI(`realplay.HLP',`Audio_Analyzer')}{button
Color Controls,JI(`realplay.HLP',`color_controls')}

See Also:

RealPlayer Menus 
Using RealPlayer 
Troubleshooting 



Volume Controls

Mutes the volume, but the clip 
will keep playing.

Raises or lowers the volume.

 More about working with clips.



Play Button

Begins playing clip.

 More about working with clips.



Pause Button

Pauses playback of the clip.

 More about working with clips.



Stop Button

Stops playback of clip and resets it to the beginning.

 More about working with clips.



Record Button

Begins recording the playing clip.

 More about recording clips.



Position Slider

Marks how far you are along in the clip. You can change your position by dragging the slider to another position.

NOTE: This is disabled for live broadcasts.

 More about working with clips.



Status Bar

The Status Bar is your main information area about your connection. Within the the Status Bar you monitor the 
status of your connection to the Internet, and various aspects about the status of the current clip. 

    More about Status Bar information.



Audio Analyzer

Both modes of the Audio Analyzer will appear here.

 More about Audio Analyzer.



Content Panel

The current view of the Content Panel shows the Channels tab. Selecting different buttons below the display 
area of this panel will change between Channels and Presets. 

Channels are your quick access to web sites and information. Click on any icon or headline to access available 
clips.

Presets are your personal favorites. Click on any Preset to connect to the content.

    More about Channels
    More about Presets



Update Headlines

Update your current Channel Headlines. Last Updated time is displayed to the left of the link.

%!JumpId(realplay.HLP,Updating_Headlines)    More about Updating

    More about Channels



Display Panel

Visual parts of clips will be shown in this part of the panel. 

 More about the Display Panel.



Clip Info Bar
Displays the Title/Author/Copyright of the current clip

 More about Clip Info Bar



Clip Info - More Info
Displays more detailed authoring and copyright information about the current clip when available.

 More about Clip Info Bar



Roll Credits
Rolls the Title/Author/Copyright infomation movie-credit style in the Clip Info bar.

 More about Clip Info Bar



Content Panel Open/Close
Opens or closes the Content Panel.

 More about the Content Panel



Compact Mode Button
Puts the Player into Compact Mode.

 More about Compact Mode.



Zoom

The zoom button allows you to resize your Display Panel to make it larger or smaller. Some or all of the zoom 
options will not be available if the presentation you are watching does not support zoom mode.

 More about full screen mode

 More about the Display Panel.



Display Color Controls

Now you can control the the look of visual presentations to suit your own tastes.    You can control the Contrast, 
Brightness, Color Saturation, Tint and Sharpness as you would on your own TV.

Click once to pop-up the control and then set each of the sliders to the appropriate level. The next time you click
anywhere, other than on the color control panel, will close the control panel but your settings will remain in 
effect.

 More about Display Color Controls

 More about the Display Panel.



Playlist Bar

When you are playing a multi-clip, a list of the various clips or it's Table of Contents will be displayed here. 

 More about Playlist Bar



Channels tab 

Opens the Channels tab.

    More about Channels



Playlist Bar

Displays which clip in a multi-clip is currently playing. You can jump to a different clip by dropping down the clip 
list and selecting a new clip.

    More about Playlists



Playlist Navigator

Moves you forward or backward through a multiclip. 

    More about Playlists



Presets tab 

Opens the Presets tab.

 More about Presets tab. 



Search bar

Search for media on the Internet by typing in phrases and words on topics of interest. Click Search and your browser will open 
and display the search results just as if you had searched for a web page.

    More about Search



Menus

Each of these is a drop-down menu to help you use RealPlayer.

    More about the RealPlayer Menus



Windows Controls

Minimize, Maximize or Close RealPlayer as you would any other program. Any accessories will be minimized or 
closed along with RealPlayer.

    More about Windows and accessories



Equalizer accessory button

Opens the Equalizer panel.

    More about the Equalizer panel



RealPlayer Add-in (RPA) button

Buttons for 3rd-party add-ins will appear in this space between the Equalizer and Compact mode.



Content Panel
The Content Panel is the central organization area for all your media browsing. The Content Panel can be 
opened or closed. When opened it occupies the left side of the Player along side the Display Panel.

 
Click to open or close the Content Panel

Click to make Visual Presets available on 
the Content Panel.

Click to make Channels available on the 
Content Panel.

See Also:

Presets and Channels 



Display Panel
The Display Panel is where all visual elements of a clip will be shown. If the Content Panel is open the Display 
Panel occupies the right half of the Player. If the Content Panel is closed, the Display Panel will span the width of 
the Player.

There are several controls on this panel:

The Zoom Control switches 
between normal, double or 
full screen mode. 

Not all options and controls 
will available at all times. 
Options will only be 
available if the presentation
you are viewing supports 
them.

Click to open the Display 
Color Controls.

The Display Color Controls 
do not work with every type
of file. They will only be 
available if the clip you are 
playing can be affected by 
the controls. They adjust, 
from left to right, Contrast, 
Brightness, Color Level, 
Hue/Tint, and Sharpness.

Contrast is the visual difference between dark and light colors.
Brightness is the overall amount of light in a picture.
Color Level is the intensity of the colors on your screen.
Hue is the amount of Red or Green in the picture.
Sharpness is how defined the edges are in the picture.



Status Bar

The Status Bar is your connection information center. Find out at a glance everything from net traffic to clip 
status. 

The information is passed to you through both text and icons:

Initially, you will see the word 
'Connecting' and the timer while the 
Player finds and connects to the 
content site.

    During buffering you will see a timer 
icon indicating that action is taking 
place, but not yet finished, the word 
Buffering... and a gauge will also be 
displayed to let you know how much 
of the buffering has been completed.

   Status of the clip (Play, Stop, Pause)
 Stream bandwidth in Kbps 

(kilobytes/sec).

When you are accessing any clip that 
utilizes the new G2 technologies, this 
status light will appear. The indicator 
is overriden by several higher priority 
messages (eg. Mute)

  Net Traffic. Your experience is only as 
good as your connection. Green 
represents a good connection, Yellow 
represents some information loss, but
it is minimal, Red tells you that there 
is severe information loss and that 
rebuffering is necessary. This will 
cause a short pause in playback.

 SureStream indicator. If your 
connection slows down due to traffic 
or line-noise, and the clip you are 
playing has been created with the 
new G2 technology, you may see 
yellow arrows indicating that the clip 
is 'downshifting' to a lower bitrate so 
you won't have to re-buffer. As the 
connection improves or if the 
connection is better than expected 
you will see green arrows indicating 
an 'upshift' in the bitrate.

Live clip (e.g., a radio station) or 
Time played/Time remaining

Clip Info Bar
The Clip Info Bar diplays the Title, Author, and Copyright for the currently playing clip or portion of a multi-clip.

Rolls the Title/Author/Copyright (TAC) in the 
Clip Info area just as the information was 
presented when you first started the clip.

Opens a dialog with additional information 
about the clip. This information is supplied 



by the content provider and will differ for 
each clip.



Playlist Bar
With a CD you can look at the insert to see the titles and order of the tracks.

Multi-clips have Playlists or Tables of Contents. Both give you a quick way to see what's part of the clip and 
allow you to access any particular clip quickly.

While a multi-clip is playing, the Playlist will display the currently running track of the clip.

To see the rest of the Playlist or Table of Contents, click . Selecting a different heading, within the active 
multi-clip, will cause the Player jump to that position within the multi-clip.

You can also click  or 

 in the Navigator display to the right of the clip name to change clips quickly in a Playlist. Each click moves 
you a clip forward or backward in the Playlist sequence.



Statistics Panel
The Statistics Panel goes beyond simple curiosity to a crazed 'need to know', but we're that way too, which is 
one of the reasons it's here for you to use. Mainly, though, it's a very good diagnostic tool if you aren't receiving 
smooth audio or visual streams .

Note: Some statistics are not displayed during local (non-streamed) playback. For instance, files played from 
your harddrive will not display the codec-typs.

There are three views of statistics available to you:

The Bandwidth tab offers general information about the speed at which your Player is receiving data. The 
information is for the sum of all streams of the current clip. The graph showing the actual receive rate over time 
runs right to left--most recent to the right.

The Packets tab offers information on the packet level of the data coming to your computer. The information is 
for the sum of all streams in the current clip.

The Streams tab offers specific information about individual streams coming to your Player. You can view stats 
on this tab by individual stream only.



What is a stream?
A Clip is a complete presentation. If there is more than just audio or just video in the current clip.

Each individual stream carries specific information about an element in the clip. One stream carries the audio 
elements, one the visual, one the text, etc. RealPlayer takes each of these streams and synchronizes them so 
that when the reporter appearing in your Display Panel opens her mouth the appropriate words come out. 

Content providers often create a clip with a number of streams so that you can hear and see the best clip your 
connection can provide. This new ability is called SureStream.

Because each clip is divided into different streams, RealPlayer optimizes your experience by choosing 
appropriate streams created for your current connection speed, or your connection preferences, or even for 
your language preference. 

See Also:

RealPlayer Plus G2 Manual Chapter 6: What is streaming?
(available on-line via Help/On-line Tutorials)



SureStream
SureStream optimizes your media experience by shifting between streams encoded at higher and lower 
bandwidths.

If there is heavy Net Traffic , RealPlayer can opt to ‘downshift’ to a stream that will have fewer problems during 
playback. Also, if you have a particularly good connection, or if congestion clears on the net, RealPlayer can 
'upshift' to a higher quality stream. 

Though SureStream usually switches between streams without any interruption in playback, you may 
occasionally experience interruptions during a stream switch. 

Watch your Status bar for information about Net Traffic and SureStream during playback.

See Also:

What is a Stream? 



 Setting Preferences
You can customize RealPlayer by changing the settings in the Preferences window (opened from the View 
menu). These settings control various aspects of RealPlayer applications, such as the number of clips RealPlayer
can remember, network information, and proxy information. These preferences apply to all applications using 
RealPlayer technology. 

Þ General Preferences 

Þ Display Preferences 

Þ Content Preferences    

Þ Upgrade Preferences 

Þ Connection Preferences 

Þ Transport Preferences 

Þ Proxy Preferences 

Þ Performance Preferences 

Þ Support Preferences 

 General Preferences
The General tab in the Preferences window contains preferences for several aspects of RealPlayer's general 
functioning.

Field Description
SmartStart (Default is On)    RealPlayer Plus can be 

launched when you start    Windows and stay
active in your Windows System Tray so 
that it responds more quickly when you 
want to play a clip. The System Tray is 
opposite your Window’s Start    button in the
same area that you see the Time and Date.   
The SmartStart icon also gives you quick 
access to Player functions and content.    
While you are connected to the Internet 
SmartStart will also keep the Headlines in 
your Channels tab updated as well as check 
for RealPlayer Plus updates even if you don’t
have RealPlayer Plus open.

Tool Tips (Default is On)    Turns on or off Tool Tips. 
Tool Tips will display information about the 
various RealPlayer controls when you hold 
your mouse stationary over them for a 
moment.

Recent Clips (Default is 8)    You can quickly replay clips 
by selecting your most recently played clips 
at the bottom of the File Menu. This setting 
controls how many clips are displayed.

Display Preferences
Display Preferences affect the look of your Player.

Audio Analyzer
Audio Analyzer levels These choices allow you to color code

the sound levels (low, medium, high) 
in your Audio Analyzer.



Status message text

Choose the color of the text on your 
Status bar .

Sampling rate Higher sampling rates provide more 
accurate visual information about the 
sound you are receiving.

Content Preferences
Content Preferences affect how content is diplayed and when it is updated.
 

Language (Default is Language initially 
installed)    By default, RealPlayer 
will display any text components in 
the language of the version you 
installed. 

If you prefer another language be 
displayed in content that provides 
more than one language, specify 
your preference here from the drop-
down list.

Channels (Default for both is On)    Enable 
or disable the automatic updating 
of your Headlines and enable or 
disable the automatic scrolling of 
Headlines in your Channels tab.

Headlines will only be updated 
while you are connected to the 
Internet. The Player will not attempt
to establish a dial-up connection 
solely for the purpose of updating 
your headlines even if you have 
automatic updating enabled.

Web browser (Default is On)    Some clips 
contain synchronized multimedia 
events that display Web pages or 
images in your browser while you 
are playing a clip. This setting 
controls whether RealPlayer 
applications enables these events.

Captions (Default is Off)    When checked, 
RealPlayer Plus will display closed 
captioning when it is provided. If 
the clip has been authored without 
captioning enabled, this setting will 
have no effect.



Upgrade Preferences
Using the Upgrade tab of the Preferences window, you can customize how often RealPlayer queries the 
RealNetworks home page to check for available upgrades. 

AutoUpdate notification alerts you to major new updates of RealPlayer. It will not inform you of individual new 
components. If you attempt to play a clip that requires additional components, RealPlayer will tell you and offer 
to find and install the new component at that time.

Field Description
Upgrade notification (Default is On)    If on, RealPlayer 

periodically contacts RealNetworks in 
the background to determine if a 
newer version or newer components 
are available for your RealPlayer Plus. 
If an upgrade is available, RealPlayer 
Plus offers to download the new files. 
All new components will be 
authenticated and installed 
automatically.

Check for upgrade 
now

Turn off upgrade 
notification for 30 
days.

Immediately contacts RealNetworks 
and ascertains if an upgrade is 
available.

If clicked, RealPlayer will stop checking
for upgrades for 30 days. At the end of 
30 days, this preference will reset and 
RealPlayer will begin to check for 
updates on a regular basis again and 
inform you when updates are 
available.

RealPlayer Listing of the different components. To 
remove a component highlight it and 
click Remove.

Warn before installing
new components.

(Default is On)    If checked, 
RealPlayer will alert you before 
attempting to install any new 
components or updates. If unchecked, 
RealPlayer will automatically begin 
installation of any new components 
that it downloads.

RealNetworks Media 
types

Occasionally the installation of a new 
program causes these file-types to no 
longer be associated with RealPlayer 
Plus. Clicking Make RealPlayer my 
default player will re-associate 
RealNetworks file-types with your 
RealPlayer Plus.

See Also:

Auto Upgrade and Security



 Connection Preferences
The Connection tab in the Preferences window contains information about your bandwidth, statistics, and server
timeout.

Field Description
Bandwid
th 

(Default is set during installation)    
RealPlayer automatically selects which 
content can be delivered in real time over 
your connection. 

The Normal setting will be automatically 
determined by the answers you give 
during installation. However, if you have a
28.8 modem but routinely connect only at 
20Kbps, you should probably set this to 
19.6Kbps. If this setting is too high you 
will experience poor playback and 
extended buffering as RealPlayer attempts
to play clips intended for higher (faster) 
bandwidths. 

The Maximum setting gives RealPlayer 
the upper limit for streams it should 
"upshift" to through SureStream.

Buffered 
Play

(Default is entire clip)    Determines 
how much RealPlayer should buffer before
beginning to play in Perfect Play mode 
[Plus only]. This does not affect regular 
playing modes.

Buffered 
Play

(Default is entire clip)    Gives you some
control over the buffering capability prior 
to playback, but does not include other 
audio enhancements of PerfectPlay.

Network 
Timeout

(Default is 20 sec. for Connection 
and 90 sec. for Server)    These settings 
determine how long RealPlayer will either try a
particular transport protocol, or will try to 
connect to a server . If this time is exceeded, 
your Player will tell you it cannot connect or 
that it has lost its connection.

 Transport Preferences
The Transport tab in the Preferences window allows you to customize your network connection for RealPlayer. 
Most likely, if you are connecting to the Internet through a commercial Internet Service Provider (ISP), you do 
not have to set any of the items on this tab.

The description of these preferences assumes a basic knowledge of Internet protocols and firewalls. For more 
information about firewalls, refer to our Web site at:

http://www.real.com/help/firewall

Field Description
Network Transport Clips can be transmitted to your computer 

via several different network transports. 
This setting controls how these network 
transports are selected.



Automatically select 
best transport:

Auto-Configure...

Use this setting if you are not aware of any 
problems that require you to specify a 
transport method.

Click Auto Configure... to have RealPlayer
automatically configure itself to use the 
most efficient mode of transport for your 
connection.

Use specified 
Transports: 

RTSP 
PNM 

Use this setting if your computer has 
problems using some network transports. 
(Consult your network administrator for the
appropriate setting.)

Select    Use specified transport...    and 
then click either PNM or RTSP to access the 
Specify Transports Window for each 
protocol.

UDP Port Some networks have limited ports available
for Internet applications. This setting 
controls which port RealPlayer applications 
use for receiving data. (Consult your 
network administrator for the appropriate 
setting.)

Note: This setting does not affect TCP 
packets, which can only be received 
through Port 7070.

Transport Settings
The Specify Transports window allows you to select the different modes of network transport that you can 
receive. You can have different settings for PNM and RTSP. (Consult your network administrator for the 
appropriate settings.)

Field Description
 Use TCP to Connect to 
Server

Select this option if you want RealPlayer to use TCP for 
the initial connection to RealServer.

Attempt to use Multicast 
for live content

Select this option if you want RealPlayer to attempt to 
receive live content through Multicast. 

If you select this option, indicate how many 
milliseconds the Player should attempt to use this type 
of transport before switching to UDP.

Attempt to use UDP for 
static content and for live 
content not available via 
Multicast

Select this option if you want RealPlayer to attempt to 
use UDP for static content and live content not 
available via Multicast.

If you select this option, indicate how many 
milliseconds the Player should attempt to use this type 
of transport before switching to TCP.

Attempt to use TCP for all 
content

Select this option if you want RealPlayer to use TCP for 
all content.

Use HTTP Only Select this option if you are behind a firewall and 
cannot receive data through TCP. All data will be 
streamed through HTTP.

Note: You may not be able to receive some content if 
you select this option.





 Proxy Preferences
A proxy is a server that acts as an intermediary between a company's protected LAN (local area network) and the Internet. The 
proxy server ensures that all data transmission between the Internet and a user on the LAN is authorized. RealPlayer can be 
configured to work with proxy servers by setting the Internet Preferences. (Since these settings are network specific there 
are no meaningful defaults. Consult your network administrator for the appropriate settings.)

For more information about proxies and firewalls, read: http://www.real.com/help/firewall

Field Description
PNA and RTSP Options:

Use PNA Proxy 
Use RTSP Proxy

Click to select either or both of these proxies if 
RealPlayer Plus should use them to connect to the 
Server. For each applicable proxy enter the appropriate 
domain name or IP address of the server and port that 
RealPlayer Plus should use to communicate with the 
proxy server. 

Note: If you are behind a firewall and do not know the 
host name or port number of your proxy server, ask 
your firewall administrator.

For information on proxy servers and RealPlayer, read:
http://www.real.com/help/firewall

HTTP Options

Use my web browser's HTTP
proxy

No HTTP proxy

Manually configure HTTP 
proxy

If you have previously set your web browser to use a 
proxy, this setting will read those existing settings and 
use them for RealPlayer.

Do not use an HTTP proxy.

Enter the domain name or IP address of the HTTP proxy 
server and port number that RealPlayer should use to 
communicate with the proxy server. Check your Web 
browser's proxy configuration.

Exceptions

Do Not Use Proxy for: 
[Host1, Host2¼] If you have specified that RealPlayer should be 

connected to the Server using a proxy, you can specify 
certain local hosts (domain names or IP Addresses) with 
which you do not need to communicate using the proxy 
server. Enter these hosts in this field. This field is only 
available if you have enabled the Use Proxy option.

Your system administrator can provide you with this 
information, if appropriate.

 Performance Preferences

Settings on the Performance tab tailor system compatiblity. In most cases you should not change them.    However, you may find 
them helpful if you have an older system or if you are experiencing specific video problems. 

Field Description
Playback Performance RealPlayer uses this setting to optimize 

the performance of clip playback. Change 
this performance setting only if your 
computer seems sluggish or has problems



while playing content.

Sound Card Compatibility
(Windows only)

Modify sound card settings to overcome 
audio problems.

Settings...

Disable 16-bit sound
(use 8-bit only)

Use this setting if you have an older 
sound card and clips sound scratchy or 
distorted.

Disable custom sampling
rates 

Use this setting if clips play at the wrong 
speed or sound scratchy or distorted.

Video Card Compatability Enable or disable optimized video. Older 
cards or video drivers may not function 
properly if this feature is enabled. If your 
video is acting erratically, one suggestion 
is to disable the optimized video.

Support Preferences

Support Preferences set how much information you would like to share with content providers.

Send Statistics Statistics help content providers refine their 
methods and improve their quality. If you do 
not wish to share your information with content
providers, do not check this box.

Send Support Info Support information helps RealNetworks 
return more meaningful error messages to you
in the event of difficulty. While this information 
is not required to receive error messages, it is 
recommended that you leave this option 
checked so that we can offer you the best 
possible assistance.

Registered location Use this setting to tell us that you've 
changed your physical location. By 
having accurate information, 
RealNetworks can connect you to the 
nearest possible server for upgrades and
other connections.



Update Frequency
RealPlayer checks for new components on a dynamic basis determined by the upgrade server each time it is 
queried. If RealNetworks knows we will have a major update soon, the RealPlayer will be asked to querey the 
server more often. If an update is unlikely, the querey time might be set for a longer delay.



 Troubleshooting
For the latest information on RealMedia products, visit the RealNetworks home page at:

http://www.real.com

A technical knowledge base, frequently asked questions list and technical library are available from our web site
at:

http://service.real.com

Please refer to your Technical Support Card for more information on contacting RealNetworks Technical Support.

See Also:

How do I configure my browser to support RealPlayer content?  
How do I get Full Screen to work?  
Why is my audio playback quality poor?  
Why is my video playback ugly? 
Why is my video not displaying or being distorted? 
Why doesn't my RealPlayer have a Volume Control slider?  
Why doesn't RealPlayer work on my computer at work or from behind a firewall?  
What types of files can RealPlayer play? 
How can I stop RealPlayer from loading when I start my computer? 
Why does RealPlayer keep trying to connect to the wrong Internet Service Provider? 



 How do I configure my browser to support RealPlayer content?
With most browsers, RealPlayer installation configures the browser to support streamed playback through your 
new RealPlayer automatically. If you change your browser and it stops recognizing files, the easiest fix is to 
reinstall RealPlayer. 

To manually configure your browser, do the following:

1. Open the Options, Preferences or Settings menu. 

2. Select the Helper Applications or a similar option. 

3. Look for "audio/x-pn-realaudio" in the File type list. If that entry exists, select that entry. 

Otherwise, click New Type. Enter audio as the Mime Type. Enter x-pn-realaudio as the Mime SubType. 
Click OK. 

4. Enter rm, ra, ram in the Extensions field. 

5. Select the Launch Application option. Browse and find the directory in which RealPlayer is installed. (By 
default, the RealPlayer is installed in c:\Real\PlayPlus\)

6. Select RealPlayer (realplay.exe) as the application to launch.

For more specific information about browsers or specific services (e.g. AOL), please refer to the following page 
on our tech support site:    http://service.real.com/help/faq/index.html.



 How do I get Full Screen to work?
If you are having problems with Full Screen (e.g. only a black screen appears), make sure that you have the 
following installed on your machine:

· Microsoft DirectX Tools with DirectDraw

You can download the most recent version and installation instructions from RealNetwork's DirectDraw 
Support page (http://service.real.com/fullscreen/default.html). When you install DirectX, you must choose to
upgrade your video drivers.

· Updated video drivers

You can find these either from the company that manufactured your video card or from RealNetworks' 
DirectDraw support page ((http://service.real.com/fullscreen/default.html. If you update your video drivers, 
you may lose old functionality of your drivers.



 Why is my audio playback poor?
The expected playback quality varies depending on bandwidth and the encoding algorithm you are playing. If 
the quality is garbled, choppy, or skips, use the following to isolate and correct the problem. 

If the quality was poor when the firstrun_plus.smi file played at the end of the RealPlayer installation, you 
have a sound card conflict. Try changing the settings on the Performance tab in the Preferences window. 

If the quality was good when the firstrun_plus.smi file played at the end of the RealPlayer installation, but is 
bad at a particular site, use the Statistics window in RealPlayer to check for lost packets. If the packet loss is 
high, it may be due to a busy network. If this is the case you should also see a net traffic warning on your Status
Bar. RealPlayer Plus users can select PerfectPlay Mode from the Options menu or connect to the site at a later 
time. RealPlayer users can use buffered play.

If the playback quality is poor on every site, do the following: 

1. Check the actual modem connection speed. This may be shown in the lighted display for external 
modems, or through an information window if you have an internal modem (check the user manual for 
your modem). Sometimes service providers use a lower rate connection speed such as 14.4 Kbps, so 
even though you are dialing in on a 28.8 Kbps modem, you are only receiving data at 14.4 Kbps. 

2. If you are using an external modem with a Windows PC and the Statistics window shows minimal packet 
loss (10% or less), there may be a problem with the speed at which packets are transferred between the 
modem and serial card. Try setting the port speed higher (at least twice the modem speed).

3. Contact RealNetworks' Technical Support at http://service.real.com



Why is my video playback ugly?
RealPlayer shows video in whatever color resolution you have your windows set to display. If your settings are 
for 256 colors, you may not get good results trying to view video clips. You should increase your screen 
resolution to 16-bit (65,000 colors) or 24-bit (over 6 million colors).

To change your screen resolution in Windows95:

1. Choose Settings/Control Panel from your Start button.

2. Double-click Display.

3. Click the Settings tab.

4. Change the Color Palette setting to High Color (16-bit) or True Color (24-bit).
(You may not be able to go to a higher color setting depending on the desktop area you have selected and 
your video card. Windows will only allow you to select choices that are appropriate for the installed video 
driver)

5. Click Apply.
(You may have to reboot to have the changes take effect, Windows will inform you if you do.)

Additionally, avoid using Zoom Mode if you do not have a high bandwidth connection or very good connection.



Why is my video not displaying or being distorted? 

To deliver the best video in the fastest possible way, RealPlayer uses the latest optimized video protocols. Not all video cards or 
their drivers will function properly with this optimized approach. If a video card or its drivers are incompatible you may see 
unexpected results (see The Symptoms below). 

The Symptoms:

Incompatability with optimized video usually displays itself in one of the following four ways:

1. You do not see any video in your RealPlayer Display panel. All you see is an empty, magenta square.

2. You do not see any video in your RealPlayer only a snowy picture that moves.

3. You see video in your RealPlayer but it has a green tint to it and may be distorted so that you only see stripes of the video or 
only part of an enlarged picture as if you were looking through a hole at a larger screen. 

4. You see video in your RealPlayer but it is stretched vertically or horizontally in only one direction distorting the picture into a 
long, flat picture or a tall, thin one.

If you are experiencing one, or more, of these symptoms, read and perform the Acid Test below to be sure that the problem is the
use of optimized video and not some other conflict.

The Acid Test-Isolating the problem:

If you are seeing any or all of the above symptoms, do the following to make sure it is an optimized video issue:

1. Connect to a video clip or click play to start playing a loaded video clip.
2. Wait until the video is exhibiting one of the above symptoms.
3. Click and hold on the menu bar of your RealPlayer.
4. Drag your RealPlayer to a new location on your desktop.

IF you saw the video playing properly while you were dragging your RealPlayer but the problems reappeared when you stopped 
dragging your RealPlayer (or shortly after you stopped dragging it):
1. Select Help/Check for Upgrade from your menus.
2. Choose Video Drivers Update if it is available (if it is not available you have the latest update and should proceed to the 

section below.
3. Click OK.
4.         AutoUpdate   will download a small (about 5K) file and automatically install it.
5. Attempt to play the video that was giving you trouble again. If it still does not display correctly, please proceed to the the 

instructions below.

If AutoUpdate does not solve your problem:
1. Select Options/Preferences from your menus.
2. Go to the Performance tab.
3. Deselect (uncheck) Use optimized video display.
4. Click OK.
5. Attempt to play the video again.

If you still do not see the video playing properly then other issues may be affecting your RealPlayer. Contact Technical Support at
http://service.real.com for access to the RealPlayer Frequently Asked Questions (FAQ) and other up-to-date and technical 
information.
If you update or change your video driver or video card, you should reselect Use optimized video display to see if it works 
properly. If it does not, follow the procedures above again to solve the conflict.



 Why doesn't my RealPlayer have a Volume Control?
In fact it does, but you are probably in Compact Mode. In Compact mode the Volume Slider changes to a pop-up 
control:

Click to pop-up the volume slider. When 
you click off of the slider, it will disappear 
again, but your setting will remain active.

As in Normal Mode, the Mute button is 
available next to the volume control.

See Also:

Keyboard Shortcuts 



 Why can't I play clips on my computer at work? 
If you're on a local area network (LAN) which is attached to the Internet, and are unable to play clilps from 
remote Web sites, it's possible that your company's firewall is preventing the stream from reaching you. Users 
can receive live and on-demand audio and video from the Internet without exposing their company's network to 
security risks.

If your computer is behind a firewall, please see RealNetworks' firewall page for more information: 
http://service.real.com/firewall



What types of files can RealPlayer G2 play?
RealPlayer G2 plays a wider variety of media both locally and over the Internet. New modules are being added 
all the time to expand RealPlayers abilities for you. If you click on a file that RealPlayer can't currently play, it 
will check with RealNetworks to see if a module exists that it can download and install for you so that you can 
play it.

Filetype:

RM, RA, RMA RealAudio/RealVideo streamed content
RT Real Text streamed text formats
RP RealPix streamed GIF and JPG ('j-peg') images
GIF, JPG Stand alone JPG and GIF images
SWF RealFlash and Shockwave Flash animation
SMIL, SMI SMIL formated (multiple datatype layout) files
VIV, VIVO Vivo video files
WAV, AU, AIFF 'Legacy' sound files--older but prevalent filetypes
QT, MOV Quicktime Movies (uncompressed)
AVI Audio/Video Interleave--Microsoft video format
ASF NetShow files (some)
MID 'MIDI' sound files

Only RealAudio, RealVideo, RealFlash, RealText, and RealPix are in the initial download. As you require or 
attempt to play different content, RealPlayer will expand its capability to fit your individual needs.

To see which components you currently have installed:

1. Click Options/Preferences

2. Click the Upgrade tab.



How can I stop RealPlayer from loading on start-up?
When RealPlayer is installed it adds a short-cut icon in your system tray (the area that shows you the date and 
time opposite the Start button). This keeps RealPlayer in idle mode so that it is quickly available should you 
click on a file that requires RealPlayer and allows your Channel Headlines to automatically update while you 
maintain a connection to the Internet. Additionally this icon allows you to function on clips that are currently 
playing even if the player is minimized. To see these functions, right-click the RealPlayer icon in your Windows 
System Tray.

If you wish to remove the icon from your Windows System Tray:

1. Right-click the icon

2. Select Close SmartStart or Disable SmartStart.

If you select Disable SmartStart, RealPlayer will no longer load when you start Windows. Close SmartStart 
will only disable the feature for the current Windows session. SmartStart will load the next time you reboot 
Windows.

To get RealPlayer to load in the system tray on start-up again:

1. Open Options/Preferences.

2. Click the General tab.

3. Click the check box in the first area: Allow SmartStart to run in the system tray.

4. RealPlayer will add SmartStart back to your system tray.



Why does RealPlayer use the wrong ISP?
When attempting to automatically to connect to the Internet, RealPlayer will select your default Internet 
connection. If you have more than one Internet Service Provider (ISP) RealPlayer may be grabbing the wrong 
one.

To change your default ISP:

1. Choose Settings/Control Panel from your Start button.

2. Double-click Internet.

· Click the Connection tab
(If you have IE4 click the Settings tab.)

3. Change the Dial-up Connection setting to your preferred ISP

4. Click Apply.



 Glossary
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The following table contains a list of terms defined specifically for RealPlayer. While some of these concepts may
have broader meanings and implications, the definitions in this Help file will relate directly to your use of the 
RealPlayer rather than the world or Internet at large.

Term Definition

accessory Accessories are parts of the Player that are not 
necessary to its main function, but that enhance your 
experience during playback (e.g. the Equalizer).

Audio 
Analyzer

A tool that analyzes the audio coming into RealPlayer 
and displays it either in a graph or wave format in the 
status window.

background When something is checked 'in the background' there is
no visual cue to alert you to the process. During a 
background process, you can continue to work 
normally.

bandwidth The amount of data over a short time that can be sent 
to your computer; usually expressed as kilobytes per 



second (Kbps). The higher the bandwidth, the faster 
you receive data. Very much like using a larger garden 
hose to get more water faster.

Sometimes this is shortened to 'band' as in the 16-band 
bar-graph equalizer. In this case, the range of sound 
that is measurable is broken into equal portions 
(ranges), or bands, of sound to be displayed.

bar A portion of the RealPlayer interface that can be 
rearranged vertically and is only a single line tall. (e.g. 
the Clip Info bar)

browser Short term for Internet browser (e.g., Netscape, Opera, 
or Internet Explorer)

buffered Data that is collected but held back rather than made 
available. Similar to a translator on the news listening to
a whole statement before telling you what the speaker 
has said, rather than trying to give you a less accurate, 
halting, word by word translation.

channel Represented by an icon in the Channels tab. It is a 
quick link to a service (news, sports, etc.) and updates 
headlines from the service it is associated with on a 
regular basis when connected to the Internet. 

clip Any media that can play within RealPlayer. 
compiled Term describing a file when the raw information, or 

source-code, has been organized into a usable format 
for your desktop. (eg. RMA, EXE, and COM file types)

datatype Determined by the program that creates the media you 
are viewing and usually distinguished by the extension 
on the end of the file (eg. AVI, WAV, RM, RMA, etc.)

directx A compilation of interpreters that allow sound and video 
to work faster in Windows95 or later and Windows NT 4
or later.

electronic 
certificates

Electronic certificates are digital fingerprints. Each file 
carries a special code identifying it as officially 
sanctioned and approved by RealNetworks to work with
your RealPlayer.

encode The process of converting media (sound, video, etc.) so
it can be streamed to and played by RealPlayer.

equalizer see graphic equalizer. 
file-type A file’s “type” is described at the front of every 

file and alerts your computer to what programs 
can use the file. Some programs can use other 
programs' file-types (e.g., word processors can 
often read other word processor documents). 
When programs are installed, certain file-types 
are associated with that program. When you 
click on a link or a file, Windows checks to see 
what program is associated with that file-type 
and automatically launches that program (e.g., 
double-clicking on a .ram file should launch 
RealPlayer Plus and begin to play a clip). 

File-type is determined by code in the file header, 
that portion of the file that is read first and tells your 
computer what programs can read it. Often file-type 
and file extension (e.g., .ram) can be used 
interchangeably, but in actuality, extensions are not 
always an indication of file-type. 

firewall Security devices used to protect companies from 
unauthorized access to their servers. A firewall 
ensures that all communication between an 
organization's network and the Internet conform to the
organization's security policies using either proxy 
services or packet filtering. 

graphic A graphic equalizer divides the sound input into smaller 



equalizer ranges of tones. This lets you adjust each range of 
sound to fit your preferences rather than just all the high
or low frequencies as typical treble and bass buttons 
do.

HTTP Hyper Text Transport Protocol. A standard language for 
pushing information across the Internet. A good fall-
back, though with reduced quality, to use when your 
company employs a firewall that blocks other protocols.

IP Internet Protocol. Part of the TCP/IP group of 
information languages.

IP address Internet address to another computer in number format 
(e.g. 127.0.0.1)

ISP Internet Service Provider. Who you use to dial up to the 
Internet if you do not have a permanent network 
connection.

media A general term that includes any visual, audio or text 
broadcast.

Multicast Used for broadcasting large events over the Internet. 
Allows a single computer to create the content (concert,
film, etc.) and many computers to play the same single 
stream.

multi-clip Any string of clips linked within a file that can play within
RealPlayer.

packet A single package of data sent to a computer. Similar to 
a single brick in a building.

panel Any one of the separate areas of the RealPlayer. Each 
is separated by lines on the top and bottom and has a 
grab-able double bar on the side that allows you to 
change the top-to-bottom order you see in your Player.

plug-in A component of the RealPlayer that extends its ability.
PNM or PNA The previous standard protocol for streaming media to 

your RealPlayer.
preset A quick button to reach content on the Internet. Like the 

station buttons on a car or home stereo.
protocol Language used by computers to talk to each other or 

to its own hardware. In the case of two computers, 
they must speak the same language to understand 
each other. The standard Internet protocol is TCP/IP .

proxy Used in conjunction with a firewall , a proxy or proxy 
service is a server that acts as an intermediary to first 
determine if a requested connection between a 
computer on the internal network and one on the 
outside is permitted. If the connection is authorized, 
the firewall sets up the necessary communication links
between the two computers. The firewall can then 
monitor the communication between the two networks
and suppress any unauthorized activity. 

RPA RealPlayer Add-in. Authorized 3rd-Party program 
additions that give you access to other media or 
functions.

RealMedia Any media that is specifically created to be streamed, 
from RealServer to your computer. 

RTSP Real Time Streaming Protocol. The newest and fastest 
protocol used to stream media to your RealPlayer over 
the internet.

sampling rate How many times a sample is taken over a specific 
period of time. 

server Any machine or program that is 'serving' information to 
another machine or program.

streaming When a large media file (audio, video, etc.) is broken 
into smaller pieces so it can viewed immediately rather 
than having to wait for the whole file to be downloaded 
first. 

TCP Transmission Control Protocol. Part of the TCP/IP group
of information languages. More reliable than UDP , but 



often slower.
TCP/IP Transmission Control Protocol/Internet Protocol. 

Standard protocol used by the Internet to send 
information back and forth.

transport Specifically how data is broken up and sent to your 
computer over the Internet or your company intranet or 
network. Each type of transport is handled differently. 
Most machines will only recognize a single type of 
transport, though this is not always the case. 
Synonymous with protocol .

UDP User Datagram Protocol. Part of the TCP/IP group of 
information languages. Similar to, but less reliable than, 
TCP, though often faster.

URL Uniform Resource Locator. This is the complete 
address that tells your browser and your RealPlayer 
where to get the information to show or play (e.g., 
www.real.com/thankyou.rm) and how to interpret that 
information (eg. RTSP ://)



Unable to Launch Web Browser

RealPlayer cannot find a web browser to launch.
Either:
1. You do not have a web browser (eg. Netscape) installed. Install a browser to avoid this message in future.
2. Your browser installed incorrectly. Reinstalling the browser should correct the problem.

-or-

3. You have very little space left on your temp drive which will cause the browser to fail. You may try to delete unnecssary files
to free space.



Unable to Connect to the Internet

Most likely, your net connection has been lost. Please reconnect and try again.
If you know you are still connected to the internet, and you connect via a company LAN, make sure auto-dial is not selected for 
Dial-up networking. If you are not sure, contact your System Administrator.



Autoconfiguration Failed

If Autoconfiguration failed, the most likely cause is that you have lost your connection to the Internet or to your company LAN. 
1. Check to make sure that your physical connections (the wires) are attached.
2. Check to see if your modem is still connected to the Internet or, if at a company, that you still have a connection to your 

network. 
· If your modem is no longer connected, turn it off for a few seconds and then on again and try to reconnect to the clip you

were trying to access.    Your modem should dial out again.
· If you are physically connected to the LAN, try rebooting to reestablish your connection.

3. If you are connected to your LAN but still unable to Autoconfigure, contact your System Administrator and tell them you are 
having a Proxy problem with the Firewall. 

For additional information about firewalls click here .



Incorrect Response Received from Error Server

Unable to connect to RealNetworks' online error help. Please check your Internet Connection.




